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Course Introduction

This course on “ICT for Communication, Collaboration and Support” has been designed in
such a way that it can be used as a self-learning material for obtaining basic knowledge and
understanding of various components (hardware as well as software) of a computer system.
All the modules presented in the course are illustrated with suitable examples wherever
required, in addition to providing links of video tutorial/s and also other OER links for further
learning at appropriate places. These enable the learners to understand the concepts easily

thereby leading to effective self-learning.
This course material consists of 5 modules.

Module 1 provides an idea on various types of collaborative activities along with discussion

on the characteristics of collaborative activities for effective classroom communication.

Module 2 explains in details the concept of collaboration and describes various types of

online forums which can be used for collaboration.

Module 3 highlights how to create and share online resources and bridge the divides. The

module also gives an idea about different types of curetting tools.

Module 4 gives an idea on local language tools and their uses. Concepts, features and

examples of some subtitling software are also discussed.

Module 5 is the last module of this course. This module provides an introduction to different
types of Assistive Technologies which can be used for helping people having functional

disabilities.

Video link : Scan with QR
Introductory Video
of Certificate on
Application of ICT
in School
Education

https://www.youtube.com/watch?v=2MB2twPqasBk
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STRUCTURE

1.1 Learning Objectives

1.2 Introduction

1.3 Meaning of Communication and Collaboration

1.4 Supporting Communication and Collaboration
1.4.1 Communication Tools
1.4.2 Facilitator's Summary
1.4.3 Characteristics of Collaborative Learning
1.4.4 Collaboration and Digital Tools
1.4.5 Types of Collaborative Activities in Class
1.4.6 Collaborative Tools

1.5 Let Us Sum Up

1.1 LEARNING OBJECTIVES

After going through this module, you will be able to -

¢ identify collaborative activities to incorporate immediately into classroom practice.

¢ identify collaborative and communication tools and platforms.

o discuss the characteristics of collaborative learning and effective communication.

¢ design unit plans and classroom activities to enhance collaborative learning and effective

communication.
1.2 INTRODUCTION

This module introduces you to the role of information and communication technology
(ICT) in enhancing community outreach, academic and research collaboration, and
education and support services (IT-CARES) in an academic setting. The module shows how
as a teacher, you use ICT tools to enhance collaboration and communication in your

classroom to encourage.

1.3 MEANING OF COMMUNICATION AND COLLABORATION

Communication is the act of conveying information for the purpose of creating a
shared understanding. It's something that humans do every day. The word “communication”
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comes from the Latin “communis,” meaning “to share,” and includes verbal, non-verbal and

electronic means of human interaction.

The act of communicating draws on several interpersonal and intra-personal skills.
These include speaking, listening, observing, questioning, processing, analyzing and
evaluating. Recipients of a message must be able to identify the sender’s intent, take into
account the message’s context, resolve any misunderstandings, accurately decode the
information and decide how to act on it. Such skills are essential to learning, forming healthy

relationships, creating a sense of community and achieving success in the workplace.

Collaboration is “a recursive process where two or more people work together toward

an intersection of common goals by sharing knowledge, learning, and building consensus.

In 1998 Chapelle said that communication is a crucial component of language
learning Environments. The term communication implies simply conveying knowledge one
way or thought of exchange. In 1997 Nykos and Hashimoto were said that Collaboration will
be taken to mean the process during which learners interact socially to create share
understanding. Many educators believe that technologies capability to support
communication and collaboration has change the classroom more than any of its other

capabilities.

Working with others is an important part of the learning process, particularly within
classrooms, networks and communities of practice. It is the interaction between learners and
between teachers aiming to develop new understanding that is at the heart of collaborative
practice. More than simply working with others, collaboration emphasizes activities where
each participant comes away with new knowledge and understanding due to their interaction
with others, sharing, contributing to and reflecting.

By interacting and negotiating meaning with others in the target language, learners

can:

Take advantage of modeling

Gain New Comprehensible language input.

Use language creatively

Work together to understand new experiences and derive meaning from them
Solve language and content problems

Gain control of a situation or person

Learn to language appropriately

VvV V.V V V V VYV V

Transfer information
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» Focus on language structure and use because computers available in
classrooms cannot respond in such a way. The effectiveness of the

collaboration tool depends on many variables.

Video link : Scan with QR Code
Communlcqtlng a.lnd https://youtu.be/T3uuHJI7Ge8 [} k -:' ]
Collaborating with
ICT R
Part-I "y
[

1.4 SUPPORTING COMMUNICATION AND COLLABORATION

Because learners are put into work groups or asked to participate does not mean that
they will interact, or that they will facilitate language learning. The teacher must plan carefully
to ensure that the interaction is effective. For instance, the use of computers to facilitate
collaboration in design education is becoming increasingly practical as networked computing
becomes cheaper, faster, and more graphical. The computer systems can indeed be used to
help students aid each other, however to be effective, they must take into account both the
nature of design and the nature of interpersonal communication, preferably in a connected
fashion. An understanding of design is assumed to be important in setting communication
goals, while an understanding of communication itself is assumed to be important in getting
students to construct and interpret exchanges such that those communication goals are
actually met. Based on the notion that a set of goals may look vastly different to a student
than to a researcher or studio instructor, the latter assumption essentially holds that design
students must be properly situated if communication between them is to unfold in a desired

way.
1.4.1 Communication Tools

Communication tools are the ‘C’ in ICT. Communication tools offer teachers a means
to improve communication and interaction among students, teachers and parents. They can
aid the teacher in reinforcing instruction, increasing the level of contemplation/discussion on

a topic or simply informing his or her audience.

Technology places a number of communication tools in your hands. Some of these

include:

» Cell phones (text messages and voicemail, VolP)
» E-mail
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Instant messaging
Electronic newsletters (e-newsletters)

Shared online calendars

Y V V VY

Class and school web pages
» Social networks.
But how do these tools help you facilitate and improve communication with students,
peers and parents, both inside and outside your classroom, it depends on students and

teacher.

Read the following extracts on educational use — (links are also available in the page on
OER links)

http://www.theedublogger.com/2013/11/11/the-top-10-ways-blogs-and-wordpress-are-used-

in-schools/

http://thanhnguyen75.blogspot.co.ke/2006/11/use-of-blogs-in-education 14.html

1.4.2 Facilitator's Summary

Collaboration in the classroom enhances learning. There are many digital tools for
teachers to use in the teaching and learning process. Common ICT applications such as
Skype, Twitter and Facebook have great educational value and can be used to create
community of learners both within and outside the classroom. Teachers need to be
innovative as they identify areas in their subject areas where they can use such collaborative

tools to enhance learning.

Effective communication is essential to create strong school-home partnerships and
to increase parental involvement. Just as teachers are skilled in the art of teaching, they also
require knowledge and skills to communicate effectively with their parent community.
Teachers should strive to use a variety of effective strategies to make communication as
informative and interactive as possible, incorporating new communication methods and yet
retaining the human touch. Every communication exchange, regardless of format, should
reflect a thoughtful, planned approach and should be viewed as an opportunity for teachers

to promote parent partnerships and ultimately, to support student learning.[1]

[11Communicating with Parents: Strategies for Teachers. (Susan Graham-Clay.) Available

online at: http://www.adi.org/journal/ss05/Graham-Clay.pdf(Copyright).
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1.4.3 Characteristics of Collaborative Learning

The characteristics of collaborative learning are:

>
>

Enhances learning — learners gain rich insights from cross-class exchanges.
Encourages ownership of ideas — each learner shapes a part of the
interaction for the group.

Develops reading/writing skills — learners use written communication skills to
exchange ideas.

Enhances teaching curriculum — provides an exciting and innovative forum for
teaching traditional subjects.

Stimulates teacher creativity — teachers develop new instructional techniques
by sharing project ideas with other colleagues.

Expands teaching and learning horizons — collaborative projects take learners
beyond the classroom to draw on family and community resources for
information, making them more aware of their social and physical
surroundings.

Integrates computer and telecommunications technology — teachers and
learners learn technical skills.

Virtual Face-To-Face experience - Because of the development of the latest
internet technologies, it become easier and convenient and gives virtual face-

to-face experience.

(Adapted from "Learning Circles" by Margaret Riel)

1.4.4 Collaboration and Digital Tools

Collaborative projects do not need to be done using the Internet. Collaboration can

take place between two classes that can meet with each other face to face — e.g. within the

same school or community. However, telecommunication adds interest and motivation to

collaboration, and has the advantage of adding different people's perspectives to the subject

being studied. Collaborative activities can take many forms and can involve individuals or

groups. It should involve four things:

YV V V VY

Two or more peers with a shared learning goal;

A workspace or learning environment that allows for collaboration;

An interactive, facilitated process or structure for the learning experience;
One or more electronic or computerized tools to support collaboration

activities.
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(Adapted from: “Collaborative Online Learning” by Audrey Choden)

1.4.5 Types of Collaborative Activities in Class

Collaborative projects can take place between classes in one school, or between
classes in different schools. The use of technology in collaborative projects has made
distance learners and teachers more accessible. The use of communication tools on the
Internet allows for quick and sometimes almost immediate access to other learners, thus
saving time and keeping the interest level high. It can also be a powerful motivator,
especially for learners who seldom have the opportunity to interact with other learners from

other communities or even other countries.

Collaborative learning allows learners access to other ideas and perspectives.
Learners have an opportunity to practice real-life data collection and it enables the
broadening of horizons. Teachers have the opportunity to share ideas and experiences with
other teachers, and to develop their community of learners beyond their immediate circle.

For many teachers this is both motivating and encouraging.

1.4.6 Collaborative Tools

There are many online collaborative tools. Each group has their own preferences.

Popular examples include Facebook and Twitter. Some more useful tools are as follows:
Dropbox: How to install and use the dropbox: https://www.dropbox.com/

Google drive: how to collaborate using google
drive: http://www.itworld.com/article/2708583/software-as-a-service/how-to-collaborate-

using-google-drive.html

Google Meet: To start or join a Google meet session, the steps can be found at:

https://apps.google.com/meet/how-it-works/

WhatsApp: this is becoming a common tool for collaboration. WhatsApp Messenger is

available for iPhone, BlackBerry, Android, Windows Phone and Nokia.

Watch the following video clip on how to install the whatsApp if you have not already
done: https://www.youtube.com/watch?v=06s8k6AOpNc

Cosco Webex: The steps to use cisco Webex, can be found in:
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https://www.lookingpoint.com/blog/how-to-use-cisco-webex
Jetsi Meet: The steps to use Jetsi meet, is as given below:
https://mashable.com/article/how-to-use-jitsi-meet-zoom-alternative/
Twiddla:

> Step by Step Handout on
Twiddla: http://nursingedtech.pbworks.com/f/Step by Step Handout on Twi

ddla.pdf
» Twiddla Video: http://www.undertenminutes.com/?p=49

» Make an Interactive Meeting with
Twiddla: http://www.youtube.com/watch?v=dLjunm-0G0O4

Crocodoc:

» Crocodoc Video: http://www.youtube.com/watch?v=Pbo-YxyA-3lI

» Crocodoc: Share & Mark Up Document Drafts

Online: http://www.makeuseof.com/dir/crocodoc-mark-up-document/

» Crocodoc — Share, Review, Collaborate on Documents

Online: http://www.ilovefreesoftware.com/09/webware/crocodoc-share-

review-collaborate-documents-online-free.html

Skype:

» How to Use Skype: A Video

Tutorial: http://www.youtube.com/watch?v=evvHXRtKA8o&feature=related

> Skype Support: https://support.skype.com/en/category/PROD/

Video link : Scan with QR Code
Communicating and | yps://youtu.be/JQMDXGiOMo0
Collaborating with
ICT
Part-11

1.5 LET US SUM UP

e Communication is the act of conveying information for the purpose of creating a

shared understanding. The word “communication” comes from the Latin “communis,’
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meaning “to share,” and includes verbal, non-verbal and electronic means of human
interaction.

e Several interpersonal and intra-personal skills, viz. speaking, listening, observing,
questioning, processing, analyzing and evaluating, etc. are involved with the act of
communication.

e Collaboration is “a recursive process where two or more people work together toward
an intersection of common goals by sharing knowledge, learning, and building
consensus.

o Working with others is an important part of the learning process. It is the interaction
between learners and between teachers aiming to develop new understanding that is
at the heart of collaborative practice.

e |t is the duty of the teacher to ensure that the interaction between the learners are
effective.

e Communication tools offer teachers a means to improve communication and
interaction among students, teachers and parents. But how do these tools help you
facilitate and improve communication with students, peers and parents, both inside
and outside the classroom, it depends on students and teacher.

e Collaboration in the classroom enhances learning. There are many digital tools for
teachers such as Skype, Twitter and Facebook which have great educational value
and can be used to create community of learners both within and outside the
classroom.

e There are several characteristics of collaboration. Collaboration can take place
between two classes that can meet with each other face to face — e.g. within the
same school or community.

e There are many online collaborative tools. Each group has their own preferences.
Some popular examples include Facebook, WhatsApp, Twitter, Google Drive,
Google Meet, etc.

References:

Links 1: http://Kictcft.or.ke/course/view.php?id=7

Links 2: Wikipedia
Links :

http://wps.pearsoned.co.uk/ema_uk_he_arnold_workpsych_5/183/47091/12055483.cw/
index.html ( Adopted multiple Choice question)
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STRUCTURE

2.1 Learning Objective

2.2 Introduction

2.3 Concept of Collaboration
2.3.1 Collaboration with SAP Net Weaver
2.3.2 Meaning of Tool/s

2.4 Meaning of Forum
2.4.1 Project Collaborations Forum
2.4.2 Company Collaborations Forum
2.4.3 Role playing Games Forum

2.5 Collaborative learning Tools
2.5.1 Communication Tools
2.5.2 Design Tools
2.5.3 Documentation Tools
2.5.4 File Sharing Tools
2.5.5 Project Management Tools
2.5.6 Software Tools

2.6 Let Us Sum Up

2.1 LEARNING OBJECTIVE

After going through this module, you will be able to —

e explain the concept of collaboration

¢ identify the need and importance of collaborative learning
e define the meaning of tools

¢ explain the concept of forums

e describe various types of online forums for collaboration
¢ identify the collaborative learning tools

o use different types of collaborative learning tools

2.2 INTRODUCTION

The purpose of a collaboration work and tool is to support a group of two or more
individuals to accomplish a common goal or objective. Collaboration tools can be either of a

non-technological nature such as paper, flipcharts, post-it notes or white-boards. They can
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also include software tools and applications such as collaborative software. This module
introduces you to the concept of collaborative and communication software learning tools

2.3 CONCEPT OF COLLABORATION

Collaboration simply means working together. In case we consider an organization,
employees in the organization collaborate by voice, email or any management tool.

Collaboration may also require:

a) Sharing of Internal-critical documents
b) Sharing News
c) Sharing Data

)
d) Interacting on someone else screen.

Many technologies have evolved to support collaboration, as all these technologies

are evolved separately much of organizations effort is spent on bringing them together.
2.3.1 Collaboration with SAP NetWeaver (NW)

SAP NetWeaver (a type of online software platform) came up with collaboration
capabilities as an additional feature of Enterprise Portal in which all the collaboration
functions at one place, which helps employees to work collectively towards a common goal.

Collaboration capabilities of NW:

a) Real Time Collaboration
b) Collaboration Rooms
c) Collaboration Launch Pad
d) Rating, Reviews and Feedback
e) Third Party Integration

a) Real Time Collaboration: Real time collaboration services include chat, instant
messaging, application sharing. You can actually see who are online and chat with
them and even share your applications with them.

b) Collaboration Rooms: These are virtual workspaces where teams to work, these
provide single point of access to tools, services and documents.

c) Collaboration Launch Pad: It provides a centralized access to your friends list,
favorite and shared documents, you can event check the availability of a person

whether he is online or not similar to a yahoo messenger.
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d) Rating, Reviews and Feedback: You can even rate a document posted in
knowledge management, and even post a review and even give a feedback on the
document.

e) Third Party Integration: you can integrate other third party applications like

Microsoft Exchange, Lotus Domino using collaboration.

2.3.2 Meaning of Tool/s

A tool is any instrument or simple piece of equipment that you hold in your hands
and use to do a particular kind of work. For example, spades, hammers, and knives are
all tools. A toolcan be a physical object such as mechanical fools including saws and

hammers or a technical object such as a web authoring tool or software program

Video link : Scan with QR Code

Tools and Forums for | 6. //youtu.be/zUbLzdmI VrY -
Collaborative Work I-
|

[=]

2.4 DEFINITION OF FORUM

Public medium (such as a newspaper column) or a place used for debates in which
anyone can participate. In Roman times it meant a public place at the center of a market or

town where open discussions on judicial, political and other issues where held.
(Read more: http://businessdictionary.com/definition/forum.html)

The Collaboration forum is for collaborations of different forum —Some of the

collaboration forums are discussed below.
2.4.1 Project Collaborations Forum

The most common collaboration by far is a project collaboration. A group of
Scratchers gets together, discusses how the project will function and who'll work on what

part, and then they go and start work. The forum topic is used as a 'headquarters' where the

group can discuss the collaboration.

There may be collaborations in the forum of other objects than projects, but these

usually do not occur.
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2.4.2 Company Collaborations Forum

Project collaborations may evolve into a company collaboration. A company
collaboration is a small group of people who work on different projects together. These
companies may grow and expand outside of scratch and create their own websites and

forums.

2.4.3 Role playing Games Forum

This forum has also been a place for role playing games to place their info about
them, usually if the info is very long and detailed. The actual role playing usually goes on in a

studio though

2.5 COLLABORATIVE LEARNING TOOLS

Collaborative learning is a situation in which two or more people learn or attempt to
learn something together. Unlike individual learning, people engaged in collaborative
learning capitalize on one another's resources and skills (asking one another for information,
evaluating one another's ideas, monitoring one another's work, etc.). More specifically,
collaborative learning is based on the model that knowledge can be created within a
population where members actively interact by sharing experiences and take on asymmetric
roles. Put differently, collaborative learning refers to methodologies and environments in
which learners engage in a common task where each individual depends on and is
accountable to each other. These include both face-to-face conversations and computer
discussions (online forums, chat rooms, etc.). Methods for examining collaborative learning

processes include conversation analysis and statistical discourse analysis.

Thus, collaborative learning is commonly illustrated when groups of students work
together to search for understanding, meaning, or solutions or to create an artifact or product
of their learning. Furthermore, collaborative learning redefines the traditional student-teacher
relationship in the classroom which results in controversy over whether this paradigm is
more beneficial than harmful. Collaborative learning activities can include collaborative
writing, group projects, joint problem solving, debates, study teams, and other activities. The

approach is closely related to cooperative learning.

Presented below various types of collaboration tools that we have found to help

remote teams to collaborate and be more efficient —
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2.5.1 Communication Tools

Communication tools are the ‘C’ in ICT. Communication tools offer teachers a means
to improve communication and interaction among students, teachers and parents. They can
aid the teacher in reinforcing instruction, increasing the level of contemplation/discussion on

a topic or simply informing his or her audience.

There are different types of communication Tools. One of the biggest reasons that
Skype is the most popular communication tool is that it's free. Skype allows audio and video
calls between multiple devices. In other words, one person could be on a laptop and
another can be on their phone. One of the most prominent features we use here at Time
Doctor is the group call. We routinely have 4, 5, and 6 people on a call from time zones all

over the world.

Acquire is a live chat software and a complete customer communication solution. The
software is built and designed for businesses of all sizes and is equipped with the latest

features to provide top-notch customer service to the customers.

The platform is featured with a full range of tool sets that includes live chat software,
chatbots, co-browsing, customer profile management, and video and voice call. There are
some other features that come with live chat software are chat history, real-time
conversation, intelligent message routing, canned messages, targeted messaging, two-way

communications, customization, analytics, and reporting.

With Acquire live chat, you can know what your visitors are looking at, which product
page they are viewing. Hence by observing customers’ behavior you can proactively start a
chat with them and can suggest them the products. This greatly impacts customer
satisfaction and improve customer retention rate and as a result, this boosts sales and ROI.
The software is compatible with any browsers and (iOS or Android) Apps. For
communication Tools we also used Acquire, lovox, Google hangouts, ,Chanty Tools, Google
Meet, Jetsi Meet, etc.

(Read More : https://biz30.timedoctor.com/online-collaboration-tools/)
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2.5.2 Design Tools

Design tools are objects, media, or computer programs, which can be used to
design. They may influence the process of production, expression and perception of
design ideas and therefore need to be applied skillfully. Invasion is an enterprise grade
prototyping tool that enables users to upload designs, create actions such as button clicks,

and gather feedback seamlessly from colleagues and customers right from within the app.

Mural is like a digital white board. It allows designers to post sticky notes, images,
and videos on a wall in order to gather quick feedback about a specific idea, design, or
prototype. It allows you to seamlessly work within the same space, an analogue to having
the entire team in the same room with access to the same white board. Keep your

collaborators in the loop with comments and live conversations no matter where you may be.

With Invision, you can manage your projects from a single dashboard. The
dashboard will show you a breakdown of project status as well as comments collected. You
can also integrate with various platforms to create a seamless design environment. As an
example of some design Tools are- Muralm, Concept Inbox, Cage, Viewflux, Zeplin, Prevue,
Red Pen etc.

(Read More: https://biz30.timedoctor.com/online-collaboration-tools/ )

2.5.3 Documentation Tools

Software documentation Tool is often written in markdown to allow for hyperlinks and
formatting while keeping it plain text so it can live alongside the code files in version control.
That means that a lot of my choices for writing tools are simple markdown editors that make
the writing experience enjoyable. At a Time Teachers work live in Google Docs. For a
remote company of over 60 employees, we have found that Google Docs is the easiest way
to collaborate, share, edit, and eventually publish documents of all kinds.

Google Docs allows us to create blog posts (like this one), spreadsheets, and
presentations. It's all for free, which is a blessing for startups and small businesses located

in various parts of the globe. We also used different types of other Tools. They are Office

21| Page



online, Etherpad, Zoho, etc. (Read More: https://biz30.timedoctor.com/online-collaboration-

tools/)

2.5.4 File Sharing Tools

File sharing is the public or private sharing of computer dataor space in
a network with various levels of access privilege. While files can easily be shared outside a
network (for example, simply by handing or mailing someone your file on a diskette), the
term file sharing almost always means sharing files in a network, even if in a small local area
network. File sharing allows a number of people to use the same file or file by some
combination of being able to read or view it, write to or modify it, copy it, or print it. Typically,
a file sharing system has one or more administrators. Users may all have the same or may
have different levels of access privilege. File sharing can also mean having an allocated
amount of personal file storage in a common file system. When you need safe storage for all
of your files, this is the app to use. You will have 15 GB of free storage for photos,
documents, and any other digital file you need to store for later use. Files are safe, but easily
accessible by you and your team, and you can access them from any device. Organize
items quickly and easily, and then share them and collaborate with your team. The different
types of tools are Google Drive,DropBox,Box, Hightail, mediafire oneDrive etc.(Read More:

https://biz30.timedoctor.com/online-collaboration-tools/ )

2.5.5 Project Management Tools

Project management includes the tools and techniques required to deliver your
projects successfully. Projects are comprised of stakeholders, their vision/goal, the
resources required to achieve that goal, and management processes and tools to make sure

you get there.

Project management is key to this success. Project management includes the
technology, methodology, and resources that enable project completion. Over time,
technology and methodology have gotten incredibly sophisticated. Project management
software helps managers control their costs and hit deadlines. It helps people deliver the
projects they commit to. It even helps them track whether or not they’'ve been paid on time
and in the right amount. Project management software has many high-level bucket features.
Plenty of people use project-management software, including everyone from airplane
builders to employees performing non-billable work. Some industries rely more heavily on
project management software than others. Consultants, service providers, and marketing

agencies commonly use project management software
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Asana is a cloud platform that enables all of your employees to log in no matter
where they are, as long as they have a wifi connection. The dashboard consists of three

panels in order to give you all of the data you need on a given project.

As a business owner, Asana will give you an overview to all projects currently going
on in your organization. This is the information on the left hand side of the dashboard. Once
you click on a particular project, the middle of the dashboard will allow you to zoom in on the
tasks associated with the project. And finally, the right hand side of the dashboard will be
even more granular. There you can see who is assigned to a particular task and when it is
due. Example of Project Management Tools are - Asana, podio, Trello, Basecamp, ProofHub

etc.

(Read More: https://biz30.timedoctor.com/online-collaboration-tools/)

2.5.6 Software Tools

A programming tool or software development tool is a computer
program that software developers use to create, debug, maintain, or otherwise support other
programs and applications. The term usually refers to relatively simple programs, that can be
combined together to accomplish a task, much as one might use multiple hand tools to fix a
physical object. The most basic tools are a source code editor and a compiler or interpreter,
which are used ubiquitously and continuously. Other tools are used more or less depending
on the language, development methodology, and individual engineer, and are often used for
a discrete task, like a debugger or profiler. Tools may be discrete programs, executed
separately — often from the command line — or may be parts of a single large program, called
an integrated development environment (IDE)At the time of this article, GitHub is the most
popular software repository on the web. According to a March 2015 Wired article, GitHub is

one of the top 100 most popular websites in the world and hosted 9 million software projects.

GitHub wraps a version control system called a Git where developers can host their

projects for free as well as exchange and talk “code” with other developers. Example of
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different tools are Bitbucket, CodePen, Usernap, Gitlab, etc. (Read More:

https://biz30.timedoctor.com/online-collaboration-tools/

For more details you may read the following important link of pdf file:

http://eprasmes.|v/wp-
content/uploads/2016/09/StudentsBook OnlineCollaborationTools V3.0.pdf

2.6 LET US SUM UP

e Collaboration means working together. In case we consider an organization,
employees in the organization collaborate by voice, email or any management tool

¢ An online software platform, SAP NetWeaver came up with collaboration capabilities
as an additional feature of Enterprise Portal in which all the collaboration functions at
one place, which helps employees to work collectively towards a common goal.

e Collaboration capabilities of NW included - Real Time Collaboration, Collaboration
Rooms, Collaboration Launch Pad, Rating, Reviews and Feedback and Third-Party

Integration.

e A Forum is a public medium or a place used for debates in which anyone can

participate. A collaboration forum is for collaborations of different forums.

e Some of the collaboration forums are Public Collaboration Forum, Company

Collaboration Forum, Role Playing Games Forum, etc.

e Collaborative learning is a situation in which two or more people learn or attempt to
learn something together. People engaged in collaborative learning capitalize on one
another's resources and skills. It is based on the model that knowledge can be
created within a population where members actively interact by sharing experiences
and take on asymmetric roles. Also, collaborative learning refers to methodologies
and environments in which learners engage in a common task where each individual
depends on and is accountable to each other. These include both face-to-face

conversations and computer discussions.

o Different types of collaboration tools that help remote teams to collaborate and be
more efficient include communication tools, design tools, documentation tools, file

sharing tools, project management tools, software tools, etc.
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STRUCTURE

3.1 Learning Objectives

3.2 Introduction

3.3 Bridging Divides: Creating, Sharing and Curation

3.4 Creating and Sharing Resources

3.4.1 Google Docs

3.4.2 Canva

3.4.3 Google Meet

3.4.4 Jitsi Meet

3.4.5 Cisco WebEx

3.5 Introduction to Some Free Content Curation Tool

3.6 Let Us Sum Up

3.1 LEARNING OBJECTIVES

After going through this module, you will be able to -

create online resources

share resources

curate resources

use Google Docs, Canva, Google Meet, Jitsi Meet and Cisco WebEx

use Canva

3.2 INTRODUCTION

In this module we will learn about bridging divides. Here we shall be able to learn

how to create and share online resources. We shall discuss about how to use google docs

and with help of google docs how we can create online resources. We shall also discuss

about how to use Canva, along with having a brief idea about different content curetting

tools.
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3.3 BRIDGING DIVIDES: CREATING, SHARING AND CURATING
RESOURCES

The term Bridging Divide refers to bring two sides closer together in order to
overcome their differences. This difference may be political, social, or any other major
difference between groups of persons. Here we will consider the difference between two
groups of people, one is the group of leaner and another the educator. ICT plays a vital role
in bridging divide. With the help of different ICT tools, we can minimize the gap between

learners and educator.

There are number of tools with which we can create, share or curate resources.
3.4 CREATING RESOURCES

Following are some free on-line tools through which we can create our own teaching

resources:
3.4.1 Google Docs

In Google Docs, we can create and edit any text documents directly in our web
browser—it does not require any special software. And even different people can work at the
same time, we can see the modification made by them, and every change is saved

automatically.
Now here we are going to learn how to use Google doc
a. To create or import doc

i. Create a new document: To create a new document file in Google Doc we have to

perform the following steps.

Choose an option:

e|In Docs click > Start a new document.

oIn Drive, click New >Google Docs >Blank document or From a template.
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E Google Docs »

ii. Import and convert old documents to Docs

If you have existing text documents, you can import and convert them to Docs.

Go to Drive.
Click New >File Upload and choose a text document from your computer. Supported
files include .doc, .docx, .dot, .html, plain text (.txt), .odt, and .rtf.

Right-click the file you want to convert and select Open with >Google Docs.

Converting your document from another program creates a copy of your original file in Docs

format. You can then edit it in your browser like any other document.

b. Edit and format

After creating or importing the document, now we can edit the document as we like. Docs

automatically saves every change we make. Let us learn how to edit and format text in

Google Docs.

i. Rename your document: At the top of the page, click Untitled document, enter a new
and click OK.
or edit text: Just click in the page and start typing.

title,
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ii. Customize the document
Depending on what we want to change, we have to choose an option:
eTo customize margins, page color, and orientation, click File >Page setup.

oTo customize text, images, tables, and more, use the toolbar options.

iii. Add pictures, links, tables, and more

The Insert menu lets you add different features to your document. Here are the highlights:
Image—Insert an image from your computer, the web, Drive, and more.

Table—Select the number of columns and rows to create a table.

Drawing—Create shapes, pictures, and diagrams right in your document.

Link—Add a link to another page or to a header or bookmark in the same document.
Bookmark—Add shortcuts to specific places within your document.

Table of contents—Create an auto-generated table of contents that links to each heading in

your document that has a heading style applied.

a Insart

™M Image..
Table

EM OCrawing..

= Link..

Bookmiark
Table of contents

iv. Create page columns

If you’re working on an academic paper or another large document, you can organize your

text in columns.

1. Click Format>Columns.
2. Select the number of columns you want.
3. (Optional) To adjust the spacing, or add lines between column, click

Format>Columns>More options.
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4. Click Apply.

=

Formnat

= Columm=s -

v. Share documents

V.

Open the file you want to share.
Click Share.
Enter the email addresses or Google Groups you want to share with.

(Note: If you can't add people outside your company, see your G Suite

administrator)

Choose what kind of access you want to grant people:
a. Can edit—Collaborators can add and edit content as well as add
comments.
b. Can comment—Collaborators can add comments, but not edit content.
c. Can view—People can view the file, but not edit or add comments.
Click Send.

Everyone you shared the document with receives an email with a link to the document.

3.4.2. CANVA

Canva is free to use, very intuitive, and most importantly, allows you to make visually

appealing and useful teaching materials in a matter of minutes and then download them to

your device or store them online for as long as you want.

8 Steps for Creating Visual Content with Canva

i. Sign Up:
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Signing up to Canva is easy. You can choose the traditional sign up route by entering your
email address and choosing a password.

Or, you can use one of your social media accounts to make it that bit quicker. Simply
connect your business’s Facebook or Google+ account and you’re ready to go.

You will be given options as to what you will be using your account for.

You will be given a personal account by default which is no different to any of the others with

regards to the features you receive.

ii. Browse the templates library to find and create the right content.

Canva has a collection of specific, professional templatesfor a wide variety of content. The
templates page is arranged into categories -- types of content -- and subcategories for
themes or topics. For example, you can choose between templates for posters and or
presentations, based on the content marketing strategy your formulated in the previous step.
Plus, each one is already optimized in the right dimensions for things like banners, headers,

and cover photos for specific sites like Facebook, Twitter or LinkedIn.

Keep in mind that these templates are meant to be your springboard to start designing. For
many creative professionals, from writers to designers, starting with a blank canvas can be
one of the biggest challenges. With these templates, you don't have to create your content

from scratch, or hire a professional designer just to create your day-to-day graphics.

iii. Find the right visuals to go with your post using Canva’s built-in photo library.

To start, type a keyword or two into the search bar, and choose from any of the photos or
illustrations -- that means no more Google image searches. The extensive photo library
hosts a wide variety of subjects and themes, like abstract images, textures, landscapes,
people, and animals. Once you’ve found the perfect image, just drag it over to your design,

and drop it where it needs to go.

Canva also allows you to upload your own images and use them on your design, which is

perfect for adding your logo and other branded visuals to content.
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iv. Marry image and text through typography.

First, pick your starter font. Then, this handy tool shows you the best font combinations for

your chosen typeface, as well as real-life examples from the web.

v. Enhance your image with a filter.
Filters are a great tool for easily changing the tone of an image. Plus, applying a custom filter
across your various posts can help to create a theme and tie your campaign together,

boosting consistency and recognizability.

To add a filter, select your image, click on the filter button, then choose from any of the 14
custom filters available in Canva. Use the slider to control the intensity of the filter. There are
also advanced options that allow you to play with different settings like brightness, contrast,

and saturation, or to add effects like a vignette.

3.4.3 Google Meet

Google Meet is a very powerful application, developed by Google Inc. In the free
version, we can connect 100 number of participants across different places under this
platform. All the participants can communicate via chat, voice and video. The most important
benefit of this application is that, it allows all the participants to present their views by sharing

their screen.
To start Google meet, we need to type the following in the address bar:
https://meet.google.com/

There are two options, we have. They are, either we can start a new meeting or we can join
meeting started by other. Once we start a meeting, a link will be created, which can be used
by all other participants to join the meeting.

Another, very important feature of Google Meet is that, the entire session can be recorded,

which can be shared later on with all the participants.
The steps to use Google meet can be found at:

https://apps.google.com/meet/how-it-works/

3.4.4 Jitsi Meet

Jitsi meet is another very popular and open source application. Since it is open source, it has
many advanced features which makes it one of the popular meeting application. We can
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start jitsi meet without password, but it is always advisable to use jitsi meet with password.
Currently, Jitsi supports 100 number of users.

The jitsi meet has many features. Some of the salient features of jitsi meet are as follows:

e We can lock a meeting room with a password.

e The screen can be shared among participants.

e Streaming a conference to YouTube live, for which Jibri is need to be
configured.

e We can share text document

¢ Raising / Lowering of hand by the participants for attention

o Participant talk-time statistics

¢ Push-to-talk mode, if any participant wants to talk.

e Play a YouTube video to all attendees.

¢ If bandwidth is low, we can choose Audio-only option.

e Telephone dial-in to a conference provided Jigasi is setup.

¢ Dial-out to a telephone participant provided Jigasi is setup

¢ Integration in other apps / websites if required.

The steps to use jitsi meet can be found in the following link.

https://meet.jit.si/

3.4. 5. Cisco WebEXx

Cisco WebEx is an IT company situated in American. The company mainly involved in
developing and selling of web conferencing and video-conferencing applications software.
Originally, it was started as WebEx in the year 1995 and later in 2007, it was taken over by
Cisco Systems. The video conferencing is delivered with a software-as-a-service (SaaS)
model through the Cisco WebEx Cloud. Cisco WebEx has got many distinguishing features,
such as:

e [t allows us to communicate and interact with anyone, anywhere, anytime to finish co-
operative projects faster.

e In real time, we can share applications, presentations, documents and our PC
desktop with the fellow participants.

e |t eliminates the need of emails among team members with collaborative online

meetings service.
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e Also, it eliminates geographic boundaries by sharing applications, presentations and
documents with the fellow participants.

e Without the time and expense of traveling, it brings people together and maximize
use of resources.

The following link will be useful and will be a guideline regarding how to use cisco webxx.

https://www.webex.com/

Video link : Scan with QR Code

Bridging DiYideS: https://youtu.be/eMT59tz3-uQ
Creating, Sharing and

Curating Resources

3.5 INTRODUCTION TO SOME FREE CONTENT CURATION TOOL

Content curation is the process of finding and collecting content which are available
online and presenting the best pieces of contents in a structured way. Unlike content
marketing, curation does not involve creating your own content. Given below are the top ten

free content curation tools which can be found on-line.

1. eLearning Tags

At elLearning Tags you can share, discover, vote and discuss interesting and remarkable
eLearning and Educational Technology content. eLearning Tags offers helpful information
on a number of topics concerning distance education including elLearning, Instructional

Design, Gamification, Social Learning, MOOCs, mLearning and more.

2. Pearltrees

Pearltrees is a free, visual and collaborative library that lets you keep everything you like at
your fingertips. A place to collect, organize and share everything you like on the web. You
can add everything you like and organize it naturally so as to enrich your collections and
collaborate on your favorite topics. Pearltrees lets you lay out you web content into trees,

which makes it an excellent tool for visual learners.

3. DiigoEducation Edition
Diigo is a multi-tool for knowledge management that is a bit more complicated than

Pearltrees. With the Diigo extension you can highlight sites that interest you the most and
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rediscover your favorite content easily. You can also create groups where users are able to
contribute and share their content.

4. Evernote

Evernote helps you remember and act upon ideas, projects and experiences across all the
computers, phones and tablets you use. You can easily capture information in any
environment using whatever device or platform you find most convenient, and makes this

information accessible and searchable at any time, from anywhere.

5. Dipity

Dipity is a great timeline creation tool that allows users to incorporate text, images, and
videos into each entry on their timeline. Like most good web tools, Dipity has a collaboration
option and has multiple options for sharing your timelines publicly or privately. iPad
compatible.

6.Storify

A social network service that lets the user create stories or timelines by blending original
content with socially distributed material and comments. It uses simple editing tools, similar
to online blogging software and offers the ability to notify creators of source material. The

best way t turn what people post on social media into compelling stories.

7. Pinterest

This site allows you to “pin” interesting images you find on the web to random boards, or
boards that carry a specific theme. The boards you create can be great fuel for your curation
projects, especially if they appeal to a broad audience. | highly encourage you to check

the 20 Tips to use Pinterest in the Classroom.

8. Symbaloo

Symbaloo is a customizable start page tool that lets users add all their most important links
in a format that is easy to use. The user can drag and drop items to organize them in a way
that is convenient and practical. The items, or tiles, can be searched so users can find those
that are most relevant to the items they are adding. News highlights and major news are also

accessible through tabs on the Symbaloo homepage.
9. Scoop.it

With Scoop.it you have the latest news delivered to you and allows you to re-share it with

your social network. The service, which has both free and premium versions, styles itself as
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a series of online magazines centered on niche topics. Another great aspect of Scoop.it is

that other people can suggest for content to be added to your pages too.

10. Curation Soft

With Curation Soft you can easily find content you want to share with your readers. A
desktop software that is self-explanatory and user-friendly. There is a paid version but also
a free one that is fully functional. The only limitation is that the free version allows you to

search content only on Google’s Blog Search.

3.6 LET US SUM UP

e The term Bridging Divide refers to bring two sides closer together in order to
overcome their differences. ICT plays a vital role in bridging divide between learners
and educators.

e There are number of tools with which we can create, share or curate resources.

e Some free online tools which can be used for creating and sharing resources are —
Google Docs, CANAVA, Google Meet, Jitsi Meet, Cisco WebEXx, etc.

e The top ten free content curation tools available online which can be used for
educative purpose are — elearning Tags, Pearltrees, DiigoEducation Edition,
Evernote, Dipity, Pinterest, Symbaloo, Scoop.it and Curation Soft.
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STRUCTURE

4.1 Learning Objectives
4.2 Introduction
4.3 Local Language Tools
4.4 Translation Tools
4.4.1 Categories of translation tools
4.5 Subtitling Tools
4.5.1 Features of Subtitling Editing Software
4.6 Let Us Sum Up

4.1 LEARNING OBJECTIVES

After going through this module, you will be able to -

¢ identify the local language tools
e use the various types of translation tools

e explain the concept, features and examples of subtitling software

4.2 INTRODUCTION

Nowadays, we often come across the term ‘localization’. What exactly does it refer
to? Does it simply mean translating some content from a foreign language to our regional or

local language?

In fact, the term ‘localization’ covers the whole process of adapting a content or product
to a specific location. Translation is just one part of localization, but localization is more
extensive. Localization also involves adapting other elements to a different location. This

may include any one or all of the following:

modifying graphics and design,
changing content to suit preferences,

using proper formatting for elements like dates, addresses and phone numbers,

YV V VYV VY

addressing local regulations and legal requirements, etc.
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Let us take the example of format of date. In the US, the date format used is mmddyy,
whereas in India it is ddmmyy. So, whenever one wants to adapt a foreign software or
content for Indian audience, the date format has to be changed to a format which the Indian

audience can recognize. This is the simplest example of localization.

In short, localization gives something the look and feel expected by the target audience.

There are various tools used for the process of localization. In this module, we shall learn
about a few of these tools, viz., local language typing software, translation tools and video

subtitling tools.

4.3 LOCAL LANGUAGE TOOLS

As Indian people are going online more and more, the need for us to communicate,
transact and get information in our native language has been increasing day by day. In this
regard, the local language tools are of much help to us. Basically, local language tools are a
kind of software using which we can type in some India’s language in editors of Windows

based applications with an Unicode complaint font.

Unicode is a computing industry standard for the consistent encoding,
representation, and handling of text expressed in most of the world's writing systems. It is an
international encoding standard for use with different languages and scripts, by which each
letter, digit, or symbol is assigned a unique numeric value that applies across different

platforms and programs.

Most of the local language tools work on the principle of transliteration. Now, what is
transliteration? Transliteration refers to the method of mapping from one system of writing
to another based on phonetic similarity. For example, when we type a sentence in Latin
letters (English alphabets), the sentence gets converted to characters that have similar

pronunciation in the target language, by the method of transliteration.

The following example will help you clearly understand the difference between

translation and transliteration:
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Original Text in English Translation in Assamese Transliteration in English

What is your name? (oIS NIy 57 R4I6 G 2GS (VN7

Some popular local language tools are:

Google Transliterate - Google Transliterate does not require users to memorize the
transliteration scheme. It works on a dictionary-based algorithm and tries to map the
Latin characters typed into the online editor with an in-built dictionary in the chosen
language. It supports phonetic transliteration using 28 languages, including 13 Indic
languages. Transliteration is done using a rich text editor. Like other artificial

intelligence algorithms, it learns organically from its user.

English — detected ~ L& P & Hindi ~ |—D ©

kites UdiT

patang

3 more translations
Fig — Example of Google Transliterate

Google IME - With the rising popularity of Google Transliterate, Google released the
Google Input Method Editor (IME) for offline use. It supports the same set of
languages as Transliterate and allows users to type in the language of choice directly
from the keyboard instead of copying and pasting it from the transliteration text

editor.

Google Input Tools

Try Google Input Tools online

Fig — Google IME
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4.4 TRANSLATION TOOLS

Localization plays a central role in the ability to customize a project to suit the needs

of users around the world. There are tools specific to the language services industry that

enables a smooth localization process with a high level of quality.

4.4.1 Categories of translation tools

Categories that localization translation tools fall into include:

Computer-assisted translation (CAT) tools - CAT tools help translators perform
the tasks of translation, bilingual review, and monolingual review as quickly as
possible and with the highest possible consistency through reuse of translated

content (also known as translation memory).

Translation memory and terminology recall are two central features of CAT tools.
They enable a translator to reuse previously translated content from old projects in
new projects. This allows them to translate a high volume of words in a shorter
amount of time while maintaining a high level of quality through terminology and style
consistency. This is especially handy for localization, as text in a lot of software and

web Uls is often the same across platforms and applications.
CAT tools are standalone pieces of software though, requiring translators that use

them to work locally and merge to a central repository. Example of such tools are

OmegaT, OmegaT+, OpenTM2 and Anaphraseus.
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2) &UsersManual-OmegaT is supplied with a comprehensive
user manual. 5

1) UsermanualsOmegaT is supplied with a comprehensive OmegaT est fourni avec un manuel d'utilisation
user manual. = || complet.
User manuals <Google Translate v2>

Editor - en/documentation. htm

Documentation

ml »

User manuals
User manuals

OmegaT is supplied with a comprehensive user manual.
OmegaT is supplied with a comprehensive user manual.<segment 0143>

To call up the manual from within OmegaT, simply select Help > Users manual,
or press F1.

An Instant Start Guide, which guides you through the main procedures and
functions of OmegaT, is displayed in the OmegaT user interface by default. -

Dictionary || Multiple Translations || Notes || Comments

1.1% (84 left) / 12.3% (361 left), 444] [52/52

Fig — OmegeT Main Window

Machine translation (MT) engines - MT engines automate the transfer of text from

one language to another. MT has three primary methodologies: rules-based,

statistical, and neural. The most widespread MT methodology is statistical, which

draws conclusions about the interconnectedness of a pair of

statistical analyses over annotated bilingual corpus data using

languages by running

n-gram models.

When a new source language phrase is introduced to the engine for translation, it

looks within its analyzed corpus data to find statistically relevant equivalents, which it

produces in the target language. MT can be useful as a productivity aid to translators,

changing their primary task from translating a source text to a target text to post-

editing the MT engine's target language output. Sample tools include Apertium &

Moses.
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Fig — Apertium sample

Translation management systems (TMS) - TMS tools are web-based platforms

that allow you to manage a localization project and enable translators and reviewers

to do what they do best. Most TMS tools aim to automate many manual parts of the

localization process by including version control system (VCS) integrations, cloud

services integrations, project reporting, as well as the standard translation memory

and terminology recall features.

These tools are most amenable to community localization or translation projects, as

they allow large groups of translators and reviewers to contribute to a project.

Examples are Weblate, Translate5, GlobalSight, Zanata & Jabylon.

@ Languages B Documents

Settings £

Languages v Sort Chinese (Taiwan) Documents
4 SearchQ 1 Search Q
Chinese (Simplified) Disabled . Tools

Chinese (Taiwan) 2

zh-TW

English (United States)

Spanish

Fig — Zanata Software
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¢ Terminology management tools - Terminology management tools give you a GUI
to create terminology resources (known as termbases) to add context and ensure
translation consistency. These resources are consumed by CAT tools and TMS
platforms to aid translators in the process of translation. Examples of such tools are

BaseTerm and Terminator.

Video link : Scan with QR Code
Local Language https://youtu.be/ZhcmrCJuivk '
Tools E E_‘
4.5 SUBTITLING TOOLS

A subtitle editor is a type of software used to create and edit subtitles to be
superimposed over, and synchronized with, video. Such editors usually provide video
preview, easy entering/editing of text, start, and end times, and control over text formatting
and positioning. Subtitle editors are available as standalone applications, as components of

many video editing software suites, and as web applications.

In television, subtitles are used for "clarification, translation, services for the deaf, as
well as identifying places or people in the news." In movies, subtitles are mainly used for
translations from foreign languages. Subtitles are frequently used to provide informative
details regarding the action on screen, such as the names and titles of interview subjects, a
discussion topic change, to spell out web URLs or email addresses, to assist understanding
speakers who mumble, details in instructional videos such as recipe ingredients, and
humorous effects such as commentary or contradictory captions. Each subtitle, during
editing, consists of text, a start time, an end time or duration, and optional text styling and

positioning.

Time is measured either in video frames, in milliseconds, or in
hours:minutes:seconds.frames/milliseconds. The exact format and separator characters
(colon, period, comma, etc.) are determined by the subtitle format chosen. A capable subtitle

editor can convert one time measurement system into another without error.

4.5.1 Features of a Subtitling Editing Tool

A subtitle editing tool will typically have these features:
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Capable of displaying a variety of video formats, loading and saving a wide variety of
subtitle file formats

Video preview: simultaneous, synchronized playback of video and subtitles, with
pause/play and fine adjustment over video: jog/shuttling/slow-motion

Text entry and editing

Search and replace of text to correct names, etc.

Spell check

Change text encoding for UTC-8, Unicode, etc.

Change the duration of a given subtitle's display

Shift subtitles or a block of subtitles back and forth in time

Change subtitle format (MicroDVD, MPSub, SubRip, ...)

Changing the time base frame rate 24, 25, 29.995, 30, etc.

Some popular subtitling software are:Aegisub, Amara, Gnome Subtitles & Subtitle Edit

Video link : Scan with QR Code
Subtitling Videos https://youtu.be/diYfLLygOSI - :.%‘FFI -
;

4.6 LET US SUM UP

The term ‘localization’ covers the whole process of adapting a content or product to a
specific location. It also involves adapting other elements to a different location.

Local language tools are a kind of software using which one can type in some India’s
language in editors of Windows based applications with an Unicode complaint font.
Unicode an international encoding standard for use with different languages and
scripts, by which each letter, digit, or symbol is assigned a unique numeric value that
applies across different platforms and programs.

Transliteration refers to the method of mapping from one system of writing to another
based on phonetic similarity. Most of the local language tools work on the principle of
transliteration.

Two of the popular local language tools are — Google Transliterate, Google IME.
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Some of the most used categories of translation tools include — Computer-Assisted
Translation (CAT) tools and Machine Translation (MT) Engines, Translation
management systems (TMS), Terminology management tools, etc.

A subtitle editor is a type of software used to create and edit subtitles to be
superimposed over, and synchronized with, video. Such editors usually provide video
preview, easy entering/editing of text, start, and end times, and control over text
formatting and positioning.

A subtitle editing tool typically have some particular features, such as, capability of
displaying a variety of video formats, showing video preview, text entry and editing,
search and replace of text to correct names, spell check, changing text encoding for
UTC-8, Unicode, etc., changing the duration of a given subtitle's display, shifting
subtitles or a block of subtitles back and forth in time, changing subtitle format,
changing the time base frame rate, etc.
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5.1 LEARNING OBJECTIVES

After going through this module, you will be able to -

o define Assistive Technology

o identify different types of Assistive Technology software

e explain Screen Readers
¢ identify various types of Screen Readers
e explain Screen Magnifiers and their features

e identify and use Audiobooks

5.2 INTRODUCTION

Assistive technology (AT) is any item, piece of equipment, software program, or
product system that is used to increase, maintain, or improve the functional capabilities of

persons with disabilities.

AT can be computer hardware: special switches, keyboards, and pointing devices or

software: screen readers, screen magnifiers and communication programs.

Most common assistive technology software are:

e Screen Readers
e Screen Magnifiers

e Audiobooks
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5.3 SCREEN READERS

Screen readers are software programs that allow blind or visually impaired users to
read the text that is displayed on the computer screen with a speech synthesizer or braille
display. A screen reader is the interface between the computer's operating system, its
applications, and the user. The user sends commands by pressing different combinations of
keys on the computer keyboard or braille display to instruct the speech synthesizer what to
say and to speak automatically when changes occur on the computer screen. A command
can instruct the synthesizer to read or spell a word, read a line or full screen of text, find a
string of text on the screen, announce the location of the computer's cursor or focused item,
and so on. In addition, it allows users to perform more advanced functions, such as locating
text displayed in a certain color, reading pre-designated parts of the screen on demand,
reading highlighted text, and identifying the active choice in a menu. Users may also use the

spell checker in a word processor or read the cells of a spreadsheet with a screen reader.

5.3.1 JAWS Screen Reader

JAWS ("Job Access With Speech") is a computer screen reader program for
Microsoft Windows that allows blind and visually impaired users to read the screen either
with a text-to-speech output or by a refreshable Braille display. JAWS is produced by the
Blind and Low Vision Group of Freedom Scientific.

JAWS supports all versions of Windows released since Windows Vista. There are
two versions of the program: the Home edition for non-commercial use and the Professional
edition for commercial environments. Before JAWS 16, the Home" edition was called
Standard, and only worked on home Windows operating systems. A DOS version,

sometimes also known as JDOS, is free.

The JAWS Scripting Language allows the user to use programs without standard

Windows controls, and programs that were not designed for accessibility.
5.3.2 Features of JAWS

JAWS allows all major functions of the Microsoft Windows operating system to be
controlled with keyboard shortcuts and spoken feedback. These shortcuts are kept as
consistent as possible throughout most programs, but the very high number of functions
needed to fluidly use modern computer software effectively requires the end user to
memorize many specific keystrokes. Virtually every aspect of JAWS can be customized by

the user, including all keystrokes and factors such as reading speed, granularity used when
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reading punctuation, and hints. JAWS also includes a scripting language to automate tasks
and make more complex modifications to the program's behavior.

The software includes a distinct mode designed specifically for web browsers,
activated when Internet Explorer or another browser is in the foreground. Support for Internet
Explorer is standard; other browsers often have compatibility issues ranging from minor to
severe. Notably, Microsoft Edge support lags behind most common third-party browsers.
When browsing web pages, JAWS first declares the title and number of links. Speech can be
stopped with the control key, lines are navigated with the up/down arrow keys, and the tab
key moves between links and controls. Specific letter keys on the keyboard can be pressed
to navigate to the next or previous element of a specific type, such as text boxes or check
boxes. JAWS can access headings in Word and PDF documents in a similar fashion.

5.3.3 Other Screen Readers

Some other popular Screen Readers include

e COBRA - Screen-reading software program that provides access to information on a
computer for people who are blind or visually impaired and converts important
information from the computer screen into speech, braille or magnified form.
Available in three versions: COBRA Zoom, which provides large print magnification
and speech output, COBRA Braille, which provides speech output and support for
more than 70 braille displays, and COBRA Pro, which includes everything.

e Orca - Free, open source screen reader for the GNOME desktop. Works with

OpenOffice, Firefox, the Java platform and other applications.

e Speakup - Screen reader for the Linux operating system. Allows users to interact
with applications and the GNU/Linux operating system with audible feedback from
the console using a speech synthesizer and to navigate around the screen using
typical screen review functions. Licensed under the GPL, the GNU General Public

License.

e VoiceOver - Screen reader built into Apple computer operating systems (Mac OS X
10.4 and later). Provides a comprehensive audible description and complete
keyboard-based navigation and access to a variety of applications, such as web
browsing, e-mail, word processing, iTunes, chat, PDF reader, media player, and

chess. Also includes support for many braille displays.
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Video link : Scan with QR Code

.Introductior.l t(_) https://youtu.be/qD2lyzB9%kpg
Different Assistive

Technologies

5.4 SCREEN MAGNIFIER

A screen magnifier is a software that interfaces with a computer's graphical output to
present enlarged screen content. By enlarging part (or all) of a screen, people with visual
impairments can better see words and images. This type of assistive technology is useful for

people with some functional vision.

The simplest form of magnification presents an enlarged portion of the original
screen content, the focus, so that it covers some or all of the full screen. This enlarged
portion should include the content of interest to the user and the pointer or cursor, also
suitably enlarged. As the user moves the pointer or cursor the screen magnifier should track
with it and show the new enlarged portion. If this tracking is jerky or flickers it is likely to
disturb the user. Also, the pointer or cursor may not be the content of interest: for example, if
the user presses a keyboard shortcut that opens a menu, the magnified portion should jump
to that menu. Pop-up windows and changes in system status can also trigger this rapid

shifting.
5.4.1 Features of Screen Magnifiers

Screen magnifiers commonly provide several features for people with particular sight

difficulties:

e Color inversion - Many people with visual impairments prefer to invert the colors,
typically turning text from black-on-white to white-on-black. This can reduce screen
glare and is wuseful for elderly people suffering from age-related macular

degeneration.
¢ Interpolation - Smoothing Text can become blocky and harder to recognize when

enlarged. Some screen magnifiers use interpolation to smooth the text to

compensate.
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e Cursor customization - The mouse and text cursors can often be modified in

several ways, such as circling it to help the user locate it on the screen.

o Different magnification modes - Screen magnifiers can alter how they present the
enlarged portion: covering the full screen, providing a lens that is moved around the

un-magnified screen, or using a fixed magnified portion.

e Crosshairs - Even with magnification, some users can find the mouse pointer hard
to see. Crosshairs, especially when their size, color and opacity are customizable,
can make the use of a pointing device easier.

5.4.2 Some examples of Screen Magnifiers
For Linux-based operating systems:

e Compiz-Fusion window manager has a highly configurable plugin named "Enhanced
Zoom Desktop"

e GNOME has gnome-mag, which as of 2015 forms part of GNOME Shell

o KDE has KMagnifier (KMag)

For MS Windows:

e MS Windows operating system has included the "Magnifier" application since

Windows 98 (released in 1998). It can integrate with a mouse-button toggle.

Apart from these built-in software, several stand-alone screen magnifier products, popular

among which are:

e Dolphin Lunar
e Virtual Magnifying Glass

e ZoomText

5.5 AUDIOBOOKS

Audiobooks are voice recordings of the text of a book that you listen to rather than
read. Audiobooks can be exact word-for-word versions of books or abridged versions. You
can listen to audiobooks on a portable music player, cellphone, computer, tablet, home

speaker system, or in cars that support streaming audio.

Now that audiobooks are available as digital audio files, they can be used on a wide

variety of consumer electronic devices. Some examples include:
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e MP3 players

e Portable media players

e Smartphones (Android and iOS)

¢ Internet tablet devices such as Kindles. Nooks, and iPads
e Home stereo systems

e Cars that support streaming audio from media players

e Computers

5.5.1 Common Digital Audiobook Formats

When you purchase or download audiobooks from the internet, they are usually in one of

the following audio formats:

e MP3
¢ WMA (Windows Media Audio)
e AAC (Advanced Audio Coding)

5.5.2 Uses of Audiobooks

Audiobooks are considered a valuable tool because of their format. Unlike traditional

books or a video program, one can listen to an audiobook while doing other tasks.

A recent survey released by the Audio Publishers Association found that the
overwhelming majority of audiobook users listen in the car, and more than two-thirds of
audiobook buyers described audiobooks as relaxing and a good way to multitask. Another
stated reason for choosing audiobooks over other formats is that an audio performance

makes some books more interesting.
Common listening practices include:

e Replaying: Depending upon one's degree of attention and interest, it is often
necessary to listen to segments of an audio book more than once to allow the
material to be understood and retained satisfactorily. Replaying may be done

immediately or after extended periods of time.

e Learning: People may listen to an audio book (usually an unabridged one) while
following along in an actual book. This helps them to learn words that they may not
learn correctly if they were only to read the book. This can also be a very effective

way to learn a new language.
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Multitasking: Many audiobook listeners choose the format because it allows
multitasking during otherwise mundane or routine tasks such as exercising, crafting,

or cooking.

Entertainment: Audiobooks have become a popular form of travel entertainment for

families or commuters.

5.6 LET US SUM UP

Assistive technology (AT) is any item, piece of equipment, software program, or
product system that is used to increase, maintain, or improve the functional
capabilities of persons with disabilities. It can be a computer hardware or software.
Most common assistive technology software are - Screen Reader, Screen Magnifiers
and Audiobooks

Screen readers are software programs that allow blind or visually impaired users to
read the text that is displayed on the computer screen with a speech synthesizer or
braille display. It act as an interface between the computer's operating system, its
applications, and the user.

One of the most common Screen Reader is JAWS Screen Reader. Some other
Screen Readers include COBRA, Orca, Speakup, VoiceOver, etc.

A screen magnifier is a software that interfaces with a computer's graphical output to
present enlarged screen content. By enlarging part or all of a screen, people with
visual impairments can better see words and images.

Screen magnifiers commonly provide several features for people with particular sight
difficulties, such as, colour inversion, interpolation, cursor customization, different
magnification modes, crosshairs, etc.

Audiobooks are voice recordings of the text of a book that one listens to. Audiobooks
can be exact word-for-word versions of books or abridged versions. One can listen to
audiobooks on a portable music player, cellphone, computer, tablet, home speaker

system, or in cars that support streaming audio.

References

Online Sources:

1. Screen Readers, American Foundation for the Blind

http: //www.afb.org/prodBrowseCatResults.aspx?CatID=49

55| Page



"Screen Readers and how the help with E-Learning”. Virginia.gov. Retrieved 13 June
2016.

https://www.vadsa.org/ace /reader.htm

Livewire "What are Audiobooks?"

https://www.lifewire.com /what-are-audiobooks-2438535

JAWS Screen Reader Demo
https://www.youtube.com /watch?v=Q1gHxM1nP00
Benefits of Reading and Listening to Audiobooks
https://www.youtube.com /watch?v=SNx8wxoeiGs

56| Page



